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[bookmark: _Toc68162707]JURISDICTION
This Administrative Settlement Agreement and Order on Consent (“Settlement Agreement”) is issued pursuant to the authority vested in the President of the United States by Section 122(g)(4) of the Comprehensive Environmental Response, Compensation, and Liability Act (CERCLA), as amended, to reach settlements in actions under Section 106 or 107 of CERCLA. The authority vested in the President has been delegated to the Administrator of the U.S. Environmental Protection Agency (EPA) by Executive Order 12580, 52 Fed. Reg. 2923 (Jan. 29, 1987), and further delegated to the Regional Administrators of the EPA by EPA Delegation No. 14-14-E (De Minimis Settlements) [insert reference to Regional redelegation, if any]. 
This Settlement Agreement is issued to [insert name] (“Respondent”). Respondent agrees to undertake all actions required by this Settlement Agreement. Respondent further consents to and will not contest EPA’s jurisdiction to issue this Settlement Agreement or to implement or enforce its terms.
EPA and Respondent agree that the actions undertaken by Respondent in accordance with this Settlement Agreement do not constitute an admission of any liability by Respondent. Respondent does not admit, and retains the right to controvert in any subsequent proceedings other than proceedings to implement or enforce this Settlement Agreement, the validity of the Statement of Facts or Determinations contained in Sections V and VI, respectively, of this Settlement Agreement.
[bookmark: _Toc68162708]PARTIES BOUND
This Settlement Agreement shall apply to and be binding upon EPA and upon Respondent and Respondent’s [heirs,] successors and assigns. Any change in ownership or corporate or other legal status of Respondent, including but not limited to, any transfer of assets or real or personal property, shall in no way alter Respondent’s responsibilities under this Settlement Agreement. Each signatory to this Settlement Agreement certifies that he or she is authorized to enter into the terms and conditions of this Settlement Agreement and to execute and bind legally the party represented by him or her.
[bookmark: _Toc68162709]STATEMENT OF PURPOSE
[NOTE: As drafted, this Statement of Purpose assumes that Respondent is providing valuable consideration which may include any combination of access, cooperation, land or other resource use restrictions, or cash in exchange for a full and final settlement with EPA for all civil liability under CERCLA §§ 106 and 107 with respect to the Site as a whole. When using this or any other Statement of Purpose, be sure that it is consistent with the Covenants by United States, the Reservations of Rights, and the definition of “matters addressed” in the Contribution provision. If institutional controls (ICs) or other response action is included in the consideration, this model should be adapted, as appropriate, as provisions relating to performance of the work, review and approval of plans, payment of future oversight costs, dispute resolution, etc. may be needed. Consult with the Office of Site Remediation Enforcement on drafting.] 
[bookmark: _Ref318890047]By entering into this Settlement Agreement, the mutual objectives of the Parties are:
to reach a final settlement between the Parties with respect to the Site pursuant to Section 122(g)(1)(B) of CERCLA, 42 U.S.C. § 6922(g)(1)(B), that allows Respondent to provide valuable consideration to EPA to resolve Respondent’s alleged civil liability under Sections 106 and 107 of CERCLA, 42 U.S.C. §§ 9606 and 9607, for injunctive relief with regard to the Site and for response costs incurred and to be incurred at or in connection with the Site, thereby reducing litigation related to the Site;
to simplify any remaining administrative and judicial enforcement activities concerning the Site by eliminating a potentially responsible party from further involvement at the Site; [and] 
[bookmark: _Ref318890037][Use this Paragraph 5.c where consideration includes a cash payment] to obtain settlement with Respondent for Respondent’s fair share of response costs incurred and to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund, and by other persons; and
to provide for full and complete contribution protection for Respondent with regard to the Site pursuant to Sections 113(f)(2) and 122(g)(5) of CERCLA, 42 U.S.C. §§ 9613(f)(2) and 9622(g)(5), or as otherwise may be provided by law, in accordance with Section XVI (Effect of Settlement/Contribution) herein.
[bookmark: _Toc68162710]DEFINITIONS
Unless otherwise expressly provided in this Settlement Agreement, terms used in this Settlement Agreement that are defined in CERCLA or in regulations promulgated under CERCLA shall have the meanings assigned to them in the statute or regulations. Whenever the terms listed below are used in this Settlement Agreement, the following definitions shall apply: 
[NOTE: In the following definition, it is generally sufficient to describe the property using the street address or the tax parcel ID number, but you also may use the legal property description. Legal property descriptions can be lengthy. It is common in conveyance documents to include the legal property description in an attachment. If using a legal property description, it should be the kind found in a deed.]
“Affected Property” shall mean all real property at the Site and any other real property, owned or controlled by Respondent, where EPA determines, at any time, that access or land, water, or other resource use restrictions are needed to implement response actions at the Site, including, but not limited to, the following properties [insert property descriptions].
“CERCLA” shall mean the Comprehensive Environmental Response, Compensation, and Liability Act, as amended, 42 U.S.C. §§ 9601-9675.
“Day” or “day” shall mean a calendar day. In computing any period of time under this Settlement Agreement, where the last day would fall on a Saturday, Sunday, or federal or State holiday, the period shall run until the close of business of the next working day.
“DOJ” shall mean the U.S. Department of Justice and its successor departments, agencies, or instrumentalities.
“Effective Date” shall mean the effective date of this Settlement Agreement as provided by Section XXI.
“EPA” shall mean the U.S. Environmental Protection Agency.
“EPA Hazardous Substance Superfund” shall mean the Hazardous Substance Superfund established by the Internal Revenue Code, 26 U.S.C. § 9507.
[NOTE: Insert the following definition only if the consideration includes a cash payment.] 
“Interest” shall mean interest at the rate specified for interest on investments of the EPA Hazardous Substance Superfund established by 26 U.S.C. § 9507, compounded annually on October 1 of each year, in accordance with 42 U.S.C. § 9607(a). The applicable rate of interest shall be the rate in effect at the time the interest accrues. The rate of interest is subject to change on October 1 of each year. Rates are available online at https://www.epa.gov/superfund/superfund-interest-rates.
“National Contingency Plan” or “NCP” shall mean the National Oil and Hazardous Substances Pollution Contingency Plan promulgated pursuant to Section 105 of CERCLA, 42 U.S.C. § 9605, codified at 40 C.F.R. Part 300, and any amendments thereto.
“Paragraph” shall mean a portion of this Settlement Agreement identified by an Arabic numeral or an upper- or lower-case letter.
“Parties” shall mean EPA and Respondent.
“Property” shall mean that portion of the “Site” that is owned by Respondent as of [insert date]. The Property is located at [insert address] in [insert City, County, State], and is designated by the following property description: ______.] [If Property and Site are the same, then define Site only, but include in the definition a description of the property.]
“RCRA” shall mean the Solid Waste Disposal Act, as amended, 42 U.S.C. §§ 6901-6992 (also known as the Resource Conservation and Recovery Act).
“Respondent” shall mean [insert name].
“Section” shall mean a portion of this Settlement Agreement identified by a Roman numeral.
“Settlement Agreement” shall mean this Administrative Settlement Agreement and Order on Consent and all appendices attached hereto. In the event of conflict between this Settlement Agreement and any appendix, the Settlement Agreement shall control.
“Site” shall mean the ______ Superfund Site, encompassing approximately ____ acres, located at [insert address or description of location] in [insert City, County, State] and [insert either: “generally shown on the map attached as Appendix A” or “generally designated by the following property description: ______.”]
[NOTE: Insert the following definition only if the consideration includes a cash payment.] 
“[Site name] Special Account” shall mean the special account, within the EPA Hazardous Substance Superfund, established for the Site by EPA pursuant to Section 122(b)(3) of CERCLA, 42 U.S.C. § 9622(b)(3), and [if applicable, identify prior settlement under which EPA established the special account].
“State” shall mean the State [or Commonwealth] of ______.
[NOTE: Insert the following definition if Section IX (Property Requirements) is included in the Settlement Agreement.]
[“Transfer” shall mean to sell, assign, convey, lease, mortgage, or grant a security interest in, or where used as a noun, a sale, assignment, conveyance, or other disposition of any interest by operation of law or otherwise.]
“United States” shall mean the United States of America and each department, agency, and instrumentality of the United States, including EPA.
[bookmark: _Ref318879631][bookmark: _Toc68162711]STATEMENT OF FACTS
[In one or more paragraphs, insert site name, location, description, National Priorities List status, and brief statement of historical hazardous substance activity at the Site.]
Hazardous substances have been or are threatened to be released at or from the Site. [NOTE: Additional information about specific hazardous substances present on- or off-site may be included and may have additional relevance to any settlement offer to a party “threatened” with contribution action as described in the Contaminated Aquifer Policy.][footnoteRef:1] [1:  The “Final Policy Toward Owners of Property Containing Contaminated Aquifers,” issued on May 24, 1995, published at 60 Fed. Reg. 34790 (July 3, 1995), suggests that Section 122(g) de minimis landowner settlements with parties threatened with contribution suits may be appropriate, where the policy applies. The policy is available online at https://www.epa.gov/enforcement/guidance-owners-property-containing-contaminated-aquifers.] 

As a result of the release or threatened release of hazardous substances, EPA has undertaken response actions at or in connection with the Site under Section 104 of CERCLA, 42 U.S.C. § 9604 [, and will undertake response actions in the future]. [OPTIONAL: Insert brief description of response actions undertaken at the Site to date by EPA or other persons, noting whether a removal, remedial investigation/feasibility study, or record of decision has been completed. Describe briefly any prior settlements for performance of work at the Site.]
In performing these response actions, EPA has incurred [and will continue to incur] response costs at or in connection with the Site. [NOTE: The dollar amount of costs incurred as of a specific date should be included. Describe briefly any previous cost recovery settlements under which any of these costs have been reimbursed to EPA by Site potentially responsible parties (PRPs).]
[Identify Respondent, the nature of Respondent’s ownership interest in the Site, and the manner in which Respondent acquired the Site, e.g., by purchase, bequest, eminent domain proceedings, etc., and the date of acquisition.]
[In one or more paragraphs, present in summary fashion the factual basis for EPA’s determination in Section VI that Respondent’s involvement with the Site is such that Respondent is eligible for settlement under the requirements of Section 122(g)(1)(B). An example follows: Respondent represents, and for the purpose of this Settlement Agreement EPA accepts, that Respondent made all appropriate inquiry into the previous uses of the [Property] [Site] [address the elements of Section 122(g)(1)(B) concerning disposal and/or contributing to a release], but did not discover that hazardous substances had been disposed of on it by a previous owner who did not disclose that information to Respondent at the time of Respondent’s acquisition of the [Property] [Site].]
EPA estimates that the total response costs incurred and to be incurred at or in connection with the Site by the EPA Hazardous Substance Superfund and by other persons is [insert either “$______” or “between $______ and $______”]. The payment required to be made by Respondent pursuant to this Settlement Agreement is a minor portion of this total amount. [NOTE: This statement need not be included if EPA is settling only for access and due care assurances. The dollar figure inserted should include the total response costs incurred to date as well as the Agency’s projection of the total response costs to be incurred during completion of response actions at the Site. The response cost total should include United States’ costs and costs incurred by other persons.]
[bookmark: _Ref318879644][bookmark: _Toc68162712]DETERMINATIONS
[bookmark: _Ref318890089]Based upon the Statement of Facts set forth above and on the administrative record for this Site, EPA has determined that:
The [insert site name] site is a “facility” as that term is defined in Section 101(9) of CERCLA, 42 U.S.C. § 9601(9).
Respondent is a “person” as that term is defined in Section 101(21) of CERCLA, 42 U.S.C. § 9601(21).
Respondent is an “owner,” as defined in Section 101(20) of CERCLA, 42 U.S.C. § 9601(20), and within the meaning of Section 107(a)(1) of CERCLA, 42 U.S.C. § 9607(a)(1), of a “facility,” as defined in Section 101(9) of CERCLA, 42 U.S.C. § 9601(9), and is a “potentially responsible party” within the meaning of Section 122(g)(1) of CERCLA, 42 U.S.C. § 9622(g)(1).
There has been an actual or threatened “release” of a “hazardous substance” from the Site as those terms are defined in Section 101(22) and (14) of CERCLA, 42 U.S.C. § 9601(22) and (14).
The actual or threatened “release” caused the incurrence of response costs.
Prompt settlement with Respondent is practicable and in the public interest within the meaning of Section 122(g)(1) of CERCLA, 42 U.S.C. § 9622(g)(1).
[bookmark: _Ref318890085]This Settlement Agreement involves at most only a minor portion of the response costs at the Site within the meaning of Section 122(g)(1) of CERCLA, 42 U.S.C. § 9622(g)(1). [NOTE: This Paragraph 14.g need not be included if EPA is settling only for access and due care assurances.]
Respondent is eligible for a de minimis settlement pursuant to Section 122(g)(1)(B) of CERCLA, 42 U.S.C. § 9622(g)(1)(B).
[NOTE: If Attorney General approval is not required for this settlement because total past and projected response costs of the United States at the Site are not expected to exceed $500,000, insert the following Paragraph 14.i and delete Section XX, Attorney General Approval.]
[bookmark: _Ref318890105][The total past and projected response costs of the United States at or in connection with the Site will not exceed $500,000, excluding interest.]
[bookmark: _Toc68162713]SETTLEMENT AGREEMENT AND ORDER
Based upon the administrative record for the Site and the Statement of Facts and Determinations set forth above, and in consideration of the promises and covenants set forth in this Settlement Agreement, the following is hereby AGREED TO AND ORDERED:
[bookmark: _Ref318879524][bookmark: _Toc68162714]PAYMENT
[NOTE: Where settlement with a de minimis landowner does not require a cash payment, delete this Section.]
[bookmark: _Ref318890126]Within 30 days after the Effective Date, Respondent shall pay to EPA $______.
Respondent shall make payment at https://www.pay.gov in accordance with the following instructions: enter “sfo 1.1” in the search field to access EPA’s Miscellaneous Payment Form – Cincinnati Finance Center. Complete the form, including the Site Name, docket number, and Site/Spill ID Number ______. 
[NOTE ABOUT SPECIAL ACCOUNTS: The Settlement Agreement should specify whether payment made under Paragraph 16 should be deposited in the EPA Hazardous Substance Superfund, or in a site-specific special account within the Hazardous Substance Superfund, or should be split between the Superfund and the Special Account (and should specify the split).]
Deposit of Payment. [Insert one of the following three sentences here.] [The total amount to be paid pursuant to Paragraph 16 shall be deposited by EPA in the EPA Hazardous Substance Superfund.] [The total amount to be paid pursuant to Paragraph 16 shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.] [Of the total amount to be paid pursuant to Paragraph 16 [“$___” or “___%”] shall be deposited by EPA in the EPA Hazardous Substance Superfund and [“$___” or “___%”] shall be deposited by EPA in the [Site name] Special Account to be retained and used to conduct or finance response actions at or in connection with the Site, or to be transferred by EPA to the EPA Hazardous Substance Superfund.]
Notice of Payment. At the time of payment, Respondent shall send notice that such payment has been made to [insert name and email address of Remedial Project Manager or other receiving official in Region]. Such notice shall reference Site Name, Site/Spill ID Number ______, and EPA docket number for this action.
[bookmark: _Toc68162715][bookmark: _Ref318879552][bookmark: _Ref395101845][bookmark: _Toc68162716]PROPERTY REQUIREMENTS
[NOTE: This Section should be used if access and/or use restrictions are needed. If access is needed to real property owned or controlled by the settlor, use Paragraph 20.a. If land, water, or other resource use restrictions are needed on real property owned or controlled by the settlor, use Paragraph 20.b. If EPA has issued a record of decision or an action memorandum that provides for ICs on real property owned by the settlor, this model should be adapted, as appropriate, as provisions relating to ICs implementation, plan review and approval, payment of future oversight costs, dispute resolution, etc. may be needed. Consult with the Office of Site Remediation Enforcement on drafting.]
[bookmark: _Ref395102100][bookmark: _Ref339368190]Agreements Regarding Access and Non-Interference. Respondent shall, with respect to its Affected Property:
[bookmark: _Ref386473580]Provide the United States [, the State,] potentially responsible parties who have entered or may enter into an agreement with the United States [or the State] for performance of response actions at the Site (hereinafter “Performing Parties”), and their representatives, contractors, and subcontractors with access at all reasonable times to its Affected Property to conduct any activity relating to response actions at the Site including the following activities:
[NOTE: Augment this list as appropriate.]
Verifying any data or information submitted to the United States [or the State];
Conducting investigations regarding contamination at or near the Site;
Obtaining samples;
Assessing the need for, planning, implementing, or monitoring response actions;
Inspecting and copying records, operating logs, contracts, or other documents maintained or generated by Respondent or its agents; 
Assessing Respondent’s compliance with the Settlement Agreement;
Determining whether the Affected Property is being used in a manner that is prohibited or restricted, or that may need to be prohibited or restricted under the Settlement Agreement; and
Implementing, monitoring, maintaining, reporting on, and enforcing [any institutional controls or] any land, water, or other resource use restrictions regarding the Affected Property.
[bookmark: _Ref386473594]Refrain from using its Affected Property in any manner that EPA determines will (i) pose an unacceptable risk to human health or to the environment due to exposure to hazardous substances or (ii) interfere with or adversely affect the implementation, integrity, or protectiveness of response actions at the Site, including the following restrictions:
[NOTE: Customize and augment this list as appropriate. Be as specific as possible.]
Prohibiting the following activities which could interfere with response actions at the Site: ______;
Prohibiting use of contaminated groundwater; 
Prohibiting the following activities which could result in exposure to contaminants in subsurface soils and groundwater: ______; 
Ensuring that any new structures on the Affected Property will not be constructed in the following manner which could interfere with response actions at the Site: ______; and
Ensuring that any new structures on the Affected Property will be constructed in the following manner which will minimize potential risk of inhalation of contaminants: ______.
Respondent shall not Transfer its Affected Property without first securing EPA’s approval of, and transferee’s consent to, an agreement that: (i) is enforceable by EPA [and the State]; and (ii) requires the transferee to provide access to and to refrain from using the Affected Property to the same extent as is provided under Paragraph 20 (Agreements Regarding Access and Non-Interference).
If EPA determines in a decision document prepared in accordance with the NCP that institutional controls in the form of state or local laws, regulations, ordinances, zoning restrictions, or other governmental controls or notices are needed regarding the Affected Property, Respondent shall cooperate with EPA’s [and the State’s] efforts to secure and ensure compliance with such institutional controls.
[bookmark: _Ref386473616]Notice to Successors-in-Title.
Respondent shall, within 15 days after the Effective Date, submit for EPA approval a notice to be filed regarding the Affected Property in the appropriate land records. The notice must: (1) include a proper legal description of the Affected Property; (2) provide notice to all successors-in-title: (i) that the Affected Property is part of, or related to, the Site; (ii) that EPA [performed / has selected] a response action for the Site [if applicable: ; and (iii) that potentially responsible parties are required to implement the response action]; and (3) identify the document requiring implementation of the response action, including, if applicable, the name and civil action or docket number of the matter. Respondent shall record the notice within 10 days after EPA’s approval of the notice and submit to EPA, within 10 days thereafter, a certified copy of the recorded notice.
Respondent shall, prior to entering into a contract to Transfer its Affected Property, or 60 days prior to Transferring its Affected Property, whichever is earlier:
Notify the proposed transferee that EPA [performed / has selected] a response action regarding the Site [if applicable: , that potentially responsible parties are required to implement response actions regarding the Site, including information identifying the document requiring such implementation,]; and
Notify EPA [and the State] of the name and address of the proposed transferee and provide EPA [and the State] with a copy of the above notice that it provided to the proposed transferee.
In the event of any Transfer of the Affected Property, unless EPA otherwise consents in writing, Respondent shall continue to comply with its obligations under the Settlement Agreement.
Notwithstanding any provision of the Settlement Agreement, EPA [and the State] retain[s] all of its [their] access authorities and rights, as well as all of its [their] rights to require institutional controls, including enforcement authorities related thereto, under CERCLA, RCRA, and any other applicable statute or regulations.
[bookmark: _Ref318882467][bookmark: _Toc68162717]DUE CARE AND COOPERATION
Nothing in this Settlement Agreement shall be construed to relieve Respondent of Respondent’s duty to exercise due care with respect to the hazardous substances at the Site or Respondent’s duty to comply with all applicable local, State, and federal laws and regulations. 
[bookmark: _Ref318890492]Respondent agrees to cooperate fully with EPA in the implementation of response actions at the Site and further agrees not to interfere with such response actions. EPA agrees, consistent with its responsibilities under applicable law, to use reasonable efforts to minimize any interference with Respondent’s operations by such entry and response. In the event Respondent becomes aware of any action or occurrence that causes or threatens a release of hazardous substances, pollutants, or contaminants at or from the Site that constitutes an emergency situation or may present an immediate threat to public health or welfare or the environment, Respondent shall immediately take all appropriate action to prevent, abate, or minimize such release or threat of release, and shall, in addition to complying with any applicable notification requirements under Section 103 of CERCLA, 42 U.S.C. § 9603, or any other law, immediately notify EPA of such release or threatened release.
[bookmark: _Ref318882945][bookmark: _Toc68162718]FAILURE TO COMPLY WITH SETTLEMENT AGREEMENT
[bookmark: _Ref318889923][If consideration includes a cash payment, insert: If Respondent fails to make full payment within the time required by Section VIII (Payment), Respondent shall pay Interest on the unpaid balance, which shall accrue from the Effective Date until the date of payment. In addition,] [insert in all settlements: [if/If] Respondent fails to comply with the requirements of [insert all that apply: Section IX (Property Requirements), or Section X (Due Care and Cooperation)], the United States may, in addition to any other available remedies or sanctions, bring an action against Respondent seeking injunctive relief to compel compliance with this Settlement Agreement and/or seeking civil penalties under Section 122(l) of CERCLA, 42 U.S.C. § 9622(l), for the failure to comply.
[bookmark: _Toc68162719]CERTIFICATION OF RESPONDENT
 By signing this Settlement Agreement, Respondent certifies [if multiple settlors: , individually,] that, to the best of its knowledge and belief, it: 
has conducted a thorough, comprehensive, good faith search for documents, and has fully and accurately disclosed to EPA, all information currently in its possession, or in the possession of its officers, directors, employees, contractors, or agents, that relates in any way to the ownership, operation, or control of the Site, or to the ownership, possession, generation, treatment, transportation, storage, or disposal of a hazardous substance, pollutant, or contaminant at or in connection with the Site; 
[bookmark: _Ref318889936]has not altered, mutilated, discarded, destroyed, or otherwise disposed of any records, reports, documents, or other information (including records, reports, documents, or other information in electronic form) (other than identical copies) relating to its potential liability regarding the Site since notification of potential liability by the United States or the State; and 
has and will comply fully with any and all EPA and State requests for information regarding the Site pursuant to Sections 104(e), 122(e)(3)(B), and 122(g)(8) of CERCLA, 42 U.S.C. §§ 9604(e), 9622(e)(3)(B), and 9622(g)(8), and Section 3007 of RCRA, 42 U.S.C. § 6927, and state law. 
[bookmark: _Ref318882711][bookmark: _Toc68162720]COVENANTS BY UNITED STATES
[bookmark: _Ref318890652]Except as specifically provided in Section XIV (Reservations of Rights by United States), the United States[footnoteRef:2] covenants not to sue or take administrative action against Respondent pursuant to Sections 106 or 107 of CERCLA, 42 U.S.C. §§ 9606 or 9607, [and Section 7003 of the RCRA, 42 U.S.C. § 6973,][footnoteRef:3] relating to the Site. With respect to present and future liability, these covenants shall take effect upon the Effective Date. These covenants are conditioned upon the satisfactory performance by Respondent of all obligations under this Settlement Agreement and the veracity of the information provided to EPA by Respondent relating to Respondent’s involvement with the Site. These covenants extend only to Respondent and do not extend to any other person. [2:  If any agency other than EPA or DOJ, such as Coast Guard or Federal Emergency Management Agency, has or may incur response costs at the Site, such costs must either be addressed in the settlement or must be expressly reserved in Paragraph 31 (general reservations).]  [3:  If including a RCRA § 7003 covenant in Paragraph 30, pursuant to Section 7003(d) of RCRA, you must offer to have a public meeting regarding the settlement and hold such a meeting if requested. To do this, include language in the Federal Register notice providing for an opportunity for a public meeting in the affected area. For guidance regarding how to comply with this requirement, see “Revised Model Notice Language for Compliance with Public Participation Requirements of Section 7003(d) of RCRA” (Oct. 30, 1996), available at https://www.epa.gov/enforcement/guidance-model-language-compliance-public-participation-requirements-under-rcra-section.] 

[bookmark: _Ref318882617][bookmark: _Toc68162721]RESERVATIONS OF RIGHTS BY UNITED STATES
[bookmark: _Ref318890645]The United States reserves, and this Settlement Agreement is without prejudice to, all rights against Respondent with respect to all matters not expressly included within Section XIII (Covenants by United States). Notwithstanding any other provision of the Settlement Agreement, the United States reserves all rights against Respondent with respect to:
[bookmark: _Ref318890458]liability for failure by Respondent to meet a requirement of this Settlement Agreement;
liability as a result of failure to exercise due care with respect to hazardous substances at the Site;
liability resulting from exacerbation by Respondent of the release or threat of release of hazardous substances from the Site;	
[bookmark: _Ref318890468]criminal liability; 		
liability for damages for injury to, destruction of, or loss of natural resources, and for the costs of any natural resource damage assessments;[footnoteRef:4] [4:  This natural resource damage reservation must be included unless the federal natural resource trustee(s) has/have agreed to a covenant not to sue pursuant to Section 122(j)(2) of CERCLA. In accordance with Section 122(j)(1) of CERCLA, where the release or threatened release of any hazardous substances at the Site may have resulted in damages to natural resources under the trusteeship of the United States, the Region should notify the federal natural resource trustee(s) of the negotiations and encourage the trustee(s) to participate in the negotiations.] 

[bookmark: _Ref318889958][include unless Respondent owns the entire Site: liability based on the ownership of the Site by Respondent when such ownership commences after signature of this Settlement Agreement by Respondent];
[bookmark: _Ref318889970]liability based on the operation of the Site by Respondent; and
[bookmark: _Ref318889979]liability based on Respondent’s transportation, treatment, storage, or disposal, or arrangement for transportation, treatment, storage, or disposal of a hazardous substance or a solid waste at or in connection with the Site, after signature of this Settlement Agreement by Respondent.
Nothing in this Settlement Agreement constitutes a covenant not to sue or to take action or otherwise limits the ability of the United States, including EPA, to seek or obtain further relief from Respondent, and the Covenants by United States in Section XIII are null and void, if information not currently known to EPA is discovered that indicates that Respondent fails to meet any of the criteria specified in Section 122(g)(1)(B) of CERCLA.
[bookmark: _Ref318882808][bookmark: _Toc68162722]COVENANTS BY RESPONDENT
[bookmark: _Ref318890695]Respondent covenants not to sue and agrees not to assert any claims or causes of action against the United States or its contractors or employees with respect to the Site[footnoteRef:5] or this Settlement Agreement including, but not limited to:  [5:  The covenants by the United States in Paragraph 30 are drafted to resolve fully Respondent’s liability for the Site as a whole. However, if this is not the case, the scope of Paragraph 33 (Covenants by Respondent) may be narrowed to conform to the scope of the United States’ covenants.] 

any direct or indirect claim for reimbursement from the EPA Hazardous Substance Superfund based on Sections 106(b)(2), 107, 111, 112, or 113 of CERCLA, 42 U.S.C. §§ 9606(b)(2), 9607, 9611, 9612, or 9613, or any other provision of law; 
any claim arising out of response actions at or in connection with the Site including any claim under the United States Constitution, the Constitution of the State [Commonwealth] of ______, the Tucker Act, 28 U.S.C. § 1491, the Equal Access to Justice Act, 28 U.S.C. § 2412, or at common law; and
[bookmark: _Ref318890718]any claim pursuant to Sections 107 and 113 of CERCLA, 42 U.S.C. §§ 9607 and 9613, Section 7002(a) of RCRA, 42 U.S.C. § 6972(a), or state law relating to the Site.[footnoteRef:6]  [6:  Wherever possible, Respondent should waive or otherwise give up claims against the United States in accordance with Paragraphs 33.c and 36 (waiver of claims). Where a claim is asserted by a potentially responsible party, or the Region has any information suggesting federal agency liability, all information relating to potential federal liability should be provided to the affected agency and DOJ as soon as possible in order to resolve any such issues, either in this settlement or a future settlement. Settlement of any federal liability will require additional revisions to this document. For information regarding CERCLA § 104(e) information requests to federal agencies, review the “Guidance on Issuing CERCLA Section 104(e)(2) Information Requests to Federal Agencies at Privately-owned Superfund Sites” (June 14, 2004), available at https://www.epa.gov/enforcement/guidance-issuing-superfund-104e2-information-requests-federal-agencies-privately-owned.] 

Except as provided in Paragraph 36 (waiver of claims) and Paragraph 41 (waiver of claim-splitting defenses), the covenants in this Section shall not apply in the event the United States brings a cause of action or issues an order pursuant to any of the reservations set forth in Section XIV (Reservations of Rights by United States), other than in Paragraph 31.a (liability for failure to meet a requirement of the Settlement Agreement) or 31.d (criminal liability), but only to the extent that Respondent’s claims arise from the same response action, response costs, or damages that the United States is seeking pursuant to the applicable reservation.
Nothing in this Settlement Agreement shall be deemed to constitute preauthorization or approval of a claim within the meaning of Section 111 of CERCLA, 42 U.S.C. § 9611, or 40 C.F.R. § 300.700(d).
[bookmark: _Ref318889995]Respondent agrees not to assert any claims and to waive all claims or causes of action (including but not limited to claims or causes of action under Section 107(a) or 113 of CERCLA) that it may have for response costs [if natural resource damage claims are being resolved through this settlement, insert: and for natural resource damages and assessment costs] relating to the Site against [if multiple Respondents insert: each other or] any other person who is a potentially responsible party under CERCLA at the Site. This waiver shall not apply with respect to any defense, claim, or cause of action that Respondent may have against any person if such person asserts a claim or cause of action relating to the Site against Respondent; nor shall it apply to any defense, claim, or cause of action arising out of action undertaken by Respondent in response to a release or threat of release in accordance with Paragraph 27 (emergency response). [NOTE: If Respondent asserts that it has a claim against a PRP within the scope of this waiver that is unrelated to the PRP’s CERCLA liability at the Site, e.g., a claim for contractual indemnification, add an exception for such claim such as the following: This waiver also shall not apply to Respondent’s contractual indemnification claim against [insert name].]
[bookmark: _Ref377116267][bookmark: _Toc68162723]EFFECT OF SETTLEMENT/CONTRIBUTION
Except as provided in Paragraph 36 (waiver of claims), nothing in this Settlement Agreement shall be construed to create any rights in, or grant any cause of action to, any person not a Party to this Settlement Agreement. Except as provided in Section XV (Covenants by Respondent), the United States and Respondent expressly reserve any and all rights (including, but not limited to, pursuant to Section 113 of CERCLA, 42 U.S.C. § 9613), defenses, claims, demands, and causes of action that they may have with respect to any matter, transaction, or occurrence relating in any way to the Site against any person not a Party hereto. Nothing in this Settlement Agreement diminishes the right of the United States, pursuant to Section 113(f)(2) and (3) of CERCLA, 42 U.S.C. § 9613(f)(2)-(3), to pursue any such persons to obtain additional response costs or response action and to enter into settlements that give rise to contribution protection pursuant to Section 113(f)(2). 
[bookmark: _Ref318890542]The Parties agree that this Settlement Agreement constitutes an administrative settlement pursuant to which Respondent has, as of the Effective Date, resolved liability to the United States within the meaning of Sections 113(f)(2) and 122(g)(5) of CERCLA, 42 U.S.C. §§ 9613(f)(2) and 122(g)(5), and is entitled, as of the Effective Date, to protection from contribution actions or claims as provided by Sections 113(f)(2) and 122(g)(5) of CERCLA, or as may be otherwise provided by law, for the “matters addressed” in this Settlement Agreement. The “matters addressed” in this Settlement Agreement are [all response actions taken or to be taken and all response costs incurred or to be incurred, at or in connection with the Site, by the United States or any other person,[footnoteRef:7] except for the State];[footnoteRef:8] provided, however, that if the United States exercises rights under the reservations in Section XIV (Reservations of Rights by United States), other than in Paragraph 31.a (liability for failure to meet a requirement of the Settlement Agreement) or 31.d (criminal liability), the “matters addressed” in this Settlement Agreement will no longer include those response costs or response actions [if the Settlement Agreement includes a natural resource damages settlement include: or natural resource damages] that are within the scope of the exercised reservation.  [7:  This definition of “matters addressed” assumes that this Settlement Agreement is designed to resolve fully Respondent’s liability at the Site. If the intended resolution of liability is narrower in scope, then the definition of “matters addressed” will need to be narrowed.]  [8:  If the State is a party and is resolving its claims regarding the Site through this Agreement, delete “except for the State.” Note that State claims do not include claims for Hazardous Substance Superfund costs that have been provided to the State through a cooperative agreement with EPA and for which EPA retains the responsibility for cost recovery.] 

The Parties further agree that this Settlement Agreement constitutes an administrative settlement pursuant to which Respondent has, as of the Effective Date, resolved liability to the United States within the meaning of Section 113(f)(3)(B) of CERCLA, 42 U.S.C. § 9613(f)(3)(B). 
Respondent shall, with respect to any suit or claim brought by it for matters related to this Settlement Agreement, notify EPA and DOJ in writing no later than 60 days prior to the initiation of such suit or claim. Respondent shall, with respect to any suit or claim brought against it for matters related to this Settlement Agreement, notify EPA and DOJ in writing within 10 days after service of the complaint or claim upon it. In addition, Respondent shall notify EPA and DOJ within 10 days after service or receipt of any Motion for Summary Judgment and within 10 days after receipt of any order from a court setting a case for trial, for matters related to this Settlement Agreement.
[bookmark: _Ref318890446]In any subsequent administrative or judicial proceeding initiated by the United States for injunctive relief, recovery of response costs, or other relief relating to the Site, Respondent shall not assert, and may not maintain, any defense or claim based upon the principles of waiver, res judicata, collateral estoppel, issue preclusion, claim-splitting, or other defenses based upon any contention that the claims raised in the subsequent proceeding were or should have been brought in the instant action; provided, however, that nothing in this Paragraph affects the enforceability of the Covenants by United States set forth in Section XIII.
[bookmark: _Ref318890008]Effective upon signature of this Settlement Agreement by Respondent, Respondent agrees that the time period [if consideration includes a cash payment: commencing on the date of its signature and ending on the date EPA receives from Respondent the payment(s) required by Section VIII (Payment) and, if any, Section XI (Failure to Comply with Settlement Agreement)] [if consideration does not include a cash payment: after the date of its signature] shall not be included in computing the running of any statute of limitations potentially applicable to any action brought by the United States related to the “matters addressed” as defined in Paragraph 38, and that, in any action brought by the United States related to the “matters addressed,” Respondent will not assert, and may not maintain, any defense or claim based upon principles of statute of limitations, waiver, laches, estoppel, or other defense based on the passage of time [if consideration includes a cash payment: during such period] [if consideration does not include a cash payment: after its signature of this Settlement Agreement]. If EPA gives notice to Respondent that it will not make this Settlement Agreement effective, the statute of limitations shall begin to run again commencing 90 days after the date such notice is sent by EPA.
[bookmark: _Toc68162724]INTEGRATION/APPENDICES
This Settlement Agreement and its appendices constitute the final, complete, and exclusive agreement and understanding between the Parties with respect to the settlement embodied in this Settlement Agreement. The Parties acknowledge that there are no representations, agreements, or understandings relating to the settlement other than those expressly contained in this Settlement Agreement. The following appendices are attached to and incorporated into this Settlement Agreement: “Appendix A” is [the map of the Site].
[NOTE: The provision below should not be used unless a Section 107(l) or 107(r) lien has been perfected. Since a qualifying de minimis landowner has to show that it purchased without knowledge of contamination, the purchase price of the property was most likely the fair market value without a reduction for contamination, and therefore the landowner would have realized no windfall due to EPA’s response work at the Site.]
[bookmark: _Toc68162725][RELEASE OF LIEN]
[Subject to the Reservation of Rights by United States in Section XIV, upon [payment of the amount specified in Section VIII (Payment)], EPA agrees to release any lien it may have on the [Site] [Property] under Section 107 of CERCLA, 42 U.S.C. § 9607, with respect to Respondent. [NOTE: If settling for access and due care only, modify so that the release of the lien takes place following the “Effective Date.”]]
[bookmark: _Ref318883257][bookmark: _Toc68162726]PUBLIC COMMENT
This Settlement Agreement shall be subject to a public comment period of at least 30 days pursuant to Section 122(i) of CERCLA, 42 U.S.C. § 9622(i). In accordance with Section 122(i)(3) of CERCLA, 42 U.S.C. § 9622(i)(3), EPA may withdraw or withhold its consent to this Settlement Agreement if comments received disclose facts or considerations that indicate that this Settlement Agreement is inappropriate, improper, or inadequate.
[bookmark: _Ref318881795][bookmark: _Ref377117017][bookmark: _Toc68162727][ATTORNEY GENERAL APPROVAL]
[NOTE: This Section should be used if Attorney General approval is required for this settlement because total past and projected response costs at the Site will exceed $500,000, excluding interest. The Region should consult with DOJ during the negotiations process and should obtain written DOJ approval of the settlement before publishing notice of the proposed Settlement Agreement in the Federal Register pursuant to Section 122(i) of CERCLA. The Region should discuss with DOJ any significant comments received during the public comment period. If the Region believes that the Settlement Agreement should be modified based upon public comment, the Region should discuss with the DOJ attorney assigned to the case whether the proposed change will require formal re-approval by DOJ.]
The Attorney General or [his/her] designee has approved the settlement embodied in this Settlement Agreement in accordance with Section 122(g)(4) of CERCLA, 42 U.S.C. § 9622(g)(4).
[bookmark: _Ref318879724][bookmark: _Toc68162728]EFFECTIVE DATE
The effective date of this Settlement Agreement shall be the date upon which EPA issues written notice to Respondent that the public comment period pursuant to Section XIX (Public Comment) has closed and that comments received, if any, do not require modification of or EPA withdrawal from this Settlement Agreement. [NOTE: If consideration includes a payment, this notice should inform Respondent that payment is now due in accordance with Paragraph 16.]
[bookmark: _Toc68162729]DISCLAIMER
This Settlement Agreement in no way constitutes a finding by EPA as to the risks to human health and the environment that may be posed by contamination at the Site nor constitutes any representation by EPA that the Site is fit for any particular purpose.


IT IS SO AGREED:

					U.S. ENVIRONMENTAL PROTECTION AGENCY:


_____________			______________________________
Dated					[Name]
					Regional Administrator, Region ___
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FOR _____________________________________:
							[Print name of Respondent]



_____________			__________________________________________
Dated					[Name]
					[Title]
					[Company]
					[Address]

[NOTE: A separate signature page is required for each settlor.]
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Instructions Regarding Automated Features

	Feature
	Instructions

	Inserting text copied from a different document
	Text copied from a different document will usually have embedded formatting codes. Pasting the text into your document will cause the formatting codes to be inserted as well, which will create unpredictable and frustrating formatting and numbering results. Therefore, ALWAYS use the “Paste Special” function to insert text copied from another document. Press Ctrl-Alt-V; in the pop-up menu, click “Unformatted Text” and OK. (You can also click the Home tab, Paste, Paste Special, Unformatted Text and OK.)

	Inserting a new paragraph
	Click at the end of the ¶ immediately preceding the place where you wish to add the new paragraph, and press Enter. To change the new ¶'s outline level use (under the Home tab) the styles menu. For example, to change ¶12.b into ¶12.a(1), click in that ¶ and then (using the Home tab) click the "LVL 3" style. To change ¶13.a into ¶14, click in that ¶ and then (using the Home tab) click the  “LVL 1” Style. Note that in consent decree models, the letters denoting each background paragraph must be manually updated.

	Adding an updateable section or paragraph cross-reference
	(a) Click where you wish to insert a cross-reference; (b) Click the “References” tab, and, in the “Captions” box, click “Cross-reference;” (c) In the pop-up menu that appears, make sure the “Reference type” field contains “Numbered item” and the “Insert reference to” field contains “Paragraph Number (full context); (d) In the “For which numbered item” field” select the numbered item (section, paragraph. or subparagraph) you wish to cross-reference, and click Insert.

	Updating the cross-references
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Update Field;” click OK. Note: If a numbered paragraph that has been cross-referenced elsewhere in the document is deleted, remove the obsolete paragraph cross-reference. Otherwise, when you update the cross-references, the following message will appear: “Error! Reference source not found.”

	Updating the table of contents
	Right-click in the TOC, and in the pop-up menu, left-click “Update Field.” Or click in the TOC, press F9, click Update Entire Table and OK. If you have just added a new section heading, click Update entire table before pressing Enter.

	Inserting a new section heading
	Click in the text of the new heading and assign the “SECTION” paragraph style to the text by clicking the “Home” tab, and in Styles box, clicking the “SECTION” style button.) That will add the section number, change the numbering of later sections, and ensure that the new section will be referenced in the table of contents.

	Changing the font
	Press Ctrl-A (to select entire document); right click; in the pop-up menu, click “Font;” in the “font” field, select a new font; click OK.




